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Intellectual Property Rights

IPRs essential or potentially essential to the present document may have been declared to ETSI. The information
pertaining to these essential IPRs, if any, is publicly available for ETSI member s and non-member s, and can be found
in ETSI SR 000 314: "Intellectual Property Rights (IPRs); Essential, or potentially Essential, IPRs notified to ETS in
respect of ETS standards’, which is available from the ETS| Secretariat. Latest updates are available on the ETSI Web
server (http://webapp.etsi.org/| PR/home.asp).

Pursuant to the ETSI IPR Palicy, no investigation, including I PR searches, has been carried out by ETSI. No guarantee
can be given as to the existence of other IPRs not referenced in ETSI SR 000 314 (or the updates on the ETSI Web
server) which are, or may be, or may become, essential to the present document.

Foreword

This Technical Report (TR) has been produced by ETSI Technical Committee Electronic Signatures and Infrastructures
(ES).

Introduction

The ETSI Technical Committee on Electronic Signatures and Infrastructures (TC ESI) has a significant number of
technical specifications that need to be maintained. This maintenance activity includes:

. tracking all comments received;

. resolving a certain number of comments;

. issuing a new revision of selected deliverables; and

. updating the maintenance report that documents the whole activity.

In order to facilitate and speed-up its maintenance activity some tools have been developed. Even though they were
devel oped to support maintenance of technical specifications within TC ESI, they are considered have wider
applicability. Therefore TC ESI decided to document them in the present document.

These tools provide ability to track the elementary comments on several technical specifications (keeping also many
details called "metadata’ as the reference to the original contributions) and record their final resolution. Starting from
the elementary comments stored in a database, these tools can automatically produce the body of an ETSI Technical
Report that documents the current status of comments on the TC ES| deliverables.

These tools can be used to:
. report to the working group;
. input to experts working on revising specifications;

. publish areport that identifies the status of maintenance activities on ETS| specifications.

ETSI
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1 Scope

The present document describes the maintenance activity as performed by TC ESI, the maintenance report and the tools
developed to simplify and speed-up the maintenance tasks.

The core of the present document is the description of the various aspects of these tools: how to install and use them,
how they work and what can be done in order to improve them.

Clause 4 contains the explanation of the maintenance process as performed by TC ESI and describes the maintenance
report; clause 5 describes the tools developed by TC ESI in order to simplify the management of the maintenance tasks.
Clause 6 describes further development of the maintenance tools that can be pursued. Annex A describes the database
structure, annex B contains the source code of the devel oped macros and the pictures of the forms and annex C includes
asample of Mail Merge template, a sample of the core of the maintenance report base file and two examples of tables
generated with the tools described in the present document and to be inserted in the maintenance report. Annex D
describes how to re-create the tools having only the present document.

2 References
For the purposes of this Technical Report (TR) the following references apply:
[1] ETSI TR 102 046 (V1.1.1): "Electronic Signatures and Infrastructures (ESI); Maintenance
Report".
[2] ETSI TR 102 046 (V1.2.1): "Electronic Signatures and Infrastructures (ESI); Maintenance
Report".
[3] ETSI SR 001 262 (V1.8.1): "ETSI drafting rules'.
3 Definitions and abbreviations

3.1 Definitions

For the purposes of the present document, the following terms and definitions apply:

contribution: every block of comments (at least one comment) received as a whole, related to only one deliverable and
identified by a unique code; it can be a complex comment or a set of comments

elementary comment: one of the atomic comments obtained by splitting a contribution during the pre-processing
stage; it could coincide with the contribution

Mail Merge: MS Word feature that performs the mail merge operation

Mail Merge database: MS Access database containing the elementary comments; it serves as data source for the Mail
Merge operation

Mail Mergetemplate: MS Word file containing the template; it includes the Mail merge fields as available from the
Mail Merge database properly formatted within atable

maintenance activity phase: historical round of the maintenance activity as performed by TC ESI

maintenance process stage: part of the revised maintenance process as improved by TC ESI during the second
mai ntenance activity phase

maintenance report: report covering the status of maintenance activity; it can be published as an ETSI Technical
Report (asdone by TC ESI)

maintenance report basefile: file containing the maintenance report except for the clause collecting the elementary
comments: this clause includes the placehol ders for the tables collecting the elementary comments for each deliverable

ETSI
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maintenance report target file: file containing the compl ete maintenance report after having launched the Mail Merge
operation and the ETSI maintenance tools

3.2 Abbreviations

For the purposes of the present document, the following abbreviations apply:

HTML HyperText Markup Language
SQL Structured Query Language
STF Specialist Task Force
VBA Visual Basic for Applications
4 Maintenance activity

4.1 History of the TC ESI maintenance activity

After having developed the first set of deliverables, TC ESI started the maintenance activity collecting all the comments
received on the published deliverables, both from inside and outside. The results of this earlier maintenance activity
resulted in a previous version of the maintenance report being published without the use of any supporting tools

(TR 102 046 [1]). This document simply collects all the comments received keeping them in their original format.

Later, a second maintenance phase has been started. In this phase it was decided to improve the maintenance process
making it more structured and to support this improved process by producing some helpful tools. The outcomes of this
second phase are:

. arevision of the maintenance process,

. the ETSI maintenance tools developed in order to support the revised maintenance report, simplifying and
speeding-up it;

. anew and completely restructured version of TR 102 046 [2] (described in clause 4.3), the TC ES
mai ntenance report that includes the output of the first phase of the maintenance activity; this maintenance
report serves as tool for the maintenance process (TC ESI internal purpose) and as public documentation of the
TC ESI maintenance activity (public purpose).

Even if the mentioned outcomes are related to the TC ESI maintenance activity, an aim of this technical committee was
to share this work with other technical committees and bodies involved in the maintenance of their deliverables. For this
purpose TC ESI decided to document its maintenance activity and toolsin an ETSI Technical Report that is constituted
by the present document.

4.2 Revised maintenance process

4.2.1 General description

The maintenance process, as revised during the second maintenance activity phase, includes many stages starting from
receiving the comments to approving and publishing the new version of the deliverables.

The purpose of the maintenance report and of the tools described in this document is helping the people involved in the
mai ntenance process by covering its first three phases:. tracking, pre-processing and processing the comments received.

For the purposes of this document and of the maintenance report, every block of comments received as a whole (at least
one comment but it can be a complex comment or a set of comments), related to only one deliverable and identified by
aunique code is "contribution”.

ETSI
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There are different subjects involved in the maintenance process:
. the STF in charge to receive the contribution and to maintain the maintenance report:
- the general maintenance STF;
. the STF in charge to produce a new version of awell defined set of deliverables:
- the maintenance STF specific for a (set of) deliverable(s);
. members of the TC ESI.

It ispossible that one ETSI STF acts both as general maintenance STF and specific maintenance STF.

4.2.2 Tracking stage

This stage is to record the contributions received from any source, keeping them in their original format. This stageis
accomplished by the general maintenance STF.

4.2.3 Pre-processing stage

A single contribution may be constituted by a set of comments or a complex comment and these comments may refer to
asingle deliverable or many deliverables; it isimpossible to know in advance how a contribution can be structured.

This stage is to transform the contributions from an unstructured form to a structured set of elementary comments: each
elementary comment is a single and simple comment with some metadata attached to.

The outcome of this stage is a collection of elementary comments grouped by deliverable; each elementary comment is
ready to be processed independently of the othersin the next stage.

This stage is accomplished by the general maintenance STF.

4.2.4 Processing stage

This stage is to resolve comments. This might be done separately for each elementary comment. However it is
suggested to operate this stage activity on a set of elementary comments all related to a single deliverable; the comment
resolution for each comment set related to one deliverable may be operated separately. Hence starting from this point it
is assumed that each set of elementary comments related to a single deliverable will be better treated as a whole block;
therefore and the mai ntenance report has been structured and the maintenance tools have been devel oped to fully
support this assumption.

For each set of elementary comments related to a single deliverable, this stage activity can be done in different ways
and by different subjects:

. by the general maintenance STF;

. by the general and specific maintenance STFs working in parallel;

. by the general maintenance STF for the initial proposal and later only by the specific maintenance STF;

. by the general maintenance STF for the initial proposal and by the members of TC ESI under an STF request.

The selection of the deliverables whose comments shall be resolved and the choice of which way to proceed is under
responsibility of the general maintenance STF; anyway this STF should get the TC ESI consensus on his choices.

ETSI
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4.3 Maintenance report

4.3.1 Maintenance report and its role in the maintenance process

The maintenance report is a document whose purpose is hel ping the people involved in the maintenance process by
covering its first three stages:. tracking, pre-processing and processing the comments received. Thisisan internal useto
a body performing the maintenance of its deliverables.

The maintenance report can also have a public purpose: it can serves as public documentation of the maintenance
activity of the body if published as ETSI Technical Report.

The document:
a) provides ameans of tracking the contributions received,
b)  organizesthe contributions under the relevant document heading;
C)  processes the comments to identify aresolution.

In particular, the current maintenance report (TR 102 046 [2]) for TC ESI is the resolute of an ongoing maintenance
process for ETSI Technical Specifications and Technical Reportsin the area of Electronic Signatures and
Infrastructures and can be considered as an example of maintenance report.

4.3.2 Structure of the maintenance report

4.3.2.1 General structure

Since the maintenance report was designed to be published as ETSI Technical Report (even if not mandatory), its
structure is compliant with the ETSI template for Technical Report and its content is to be written, organized and
formatted to be compliant with SR 001 262 [3]. The structure of the maintenance report is as follows:

. from the cover page to clause 3 included asthe ETSI template for Technical Report makes provision;

. clause 4 describes the structure of the maintenance report itself and its content is reported in the subsequent
subclauses of the present document;

. clause 5 constitutes the body of the maintenance report and includes al the elementary comments, grouped in
tables, one for each deliverable (see clause 4.3.2.2 for the description of clause 5);

. annex A includes all the received contributions keeping the original formatting as much as possible (see
clause 4.3.2.3 for the description of annex A).

4322 Clause 5: fields and structure

Clause 5 congtitutes the main part of the maintenance report; it is the outcome of the organizing the contributions under
the relevant heading and records the proposed resolution of the comment. The elementary comments and their metadata
have been inserted in a database (the Mail Merge database); the tables for each deliverable included in the clause 5 are
automatically generated from the data stored in the aforementioned database using the Mail Merge feature made
available by MS Word and the ETSI maintenance tools described later in the present document.

Clause 5 collects the elementary comments grouped by deliverable. The set of comments related to a single deliverable
are put in asingle table. If the original contribution isacomplex comment or a set of comments, the contribution is split
into a number of single elementary comments. In the table, the comments are grouped and ordered by the number of the
section they apply to. When the comments are effectively applied to atarget deliverable, they are retained in the new
version of the maintenance report soon after their application, then in the subsequent version these comments will be
removed.

ETSI
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The data and the metadata for each elementary comment are:

4.3.2.3

deliverable 1D, version and section which the comments are applied to (are the ones defined in annex A for
each contribution);

source (person and organization or group) and date of the comment;

ID of the elementary comment (<deliverable |ID>-<unique_code>: e.g. "TS1015456-001"; the <unique_code>
is a per-deliverable unique al phanumeric code and it consists of three characters; the progression of the codes
is: from "000" to "999" then from "AAA" to "ZZZ" using the twenty six letters of the English alphabet);

reference to the original contribution;

elementary comment's text;

elementary comment's type; the values for this field may be only:
- editorial;

- technical;

original proposal for comment resolution;

resolution comment (only for the following status values. provisionally approved, applied, already applied,
rejected, no change);

resolution text (only for the following status values: provisionally approved, applied, already applied);

resolution date (only for the following status values: provisionally approved, applied, already applied,
rejected, no change);

source of the comment resolution: person and group (general maintenance STF, specific maintenance STF,
TC ESI group);

status of comment resolution: the values for thisfield may be only:
- not yes processed;
- in process,

- provisionally approved (resolution date field shall be filled in; the resolution comment field may be
filled in);

- applied (resolution date and target version fields shall be filled in; the resolution comment field may be
filled in);

- already applied (resolution date and target version fields shall be filled in; the resolution comment field
may be filled in);

- rejected (resolution date and resolution comment - with the reason - fields shall be filled in);
- no change (resolution date and resolution comment - with the reason - fields shall befilled in);

version of the target deliverable.

Annex A: fields and structure

Annex A of the maintenance report collects all comments received in their original format grouped by originator, then
by deliverable. Annex A isthe outcome of the tracking stage and could be intended as a historical section. If the text
received as a whole includes comments on more deliverables, the text is split into blocks, each related to only one
deliverable. Thisisthe only elaboration done on the comments received. Every block of comments (at least one
comment) received as awhole and related to only one deliverableis called contribution and isidentified by a unique
code. If received in different times, two (blocks of) comments have different identifier even if have been originated by
the same source and are related to the same deliverable: they are two different contributions. In this case they are placed
in different clausesin annex A.

ETSI



11 ETSI TR 102 317 V1.1.1 (2004-06)

The data and the metadata for each contribution are:

. ID of the contribution (with a unique prefix for each source: <Source |D>-<unique_code>: e.g. "TC ESI_1-
001"; the <unique_code> is a per-source unique a phanumeric code and it consists of three characters; the
progression of the codesis: from "000" to "999" then from "AAA" to "ZZZ" using the twenty six letters of the
English alphabet) to be referenced in the clause 5;

. source (person and organization or group that originates the contribution) of the contribution;
. date of the contribution;
. version which the contribution is referred to;

. original text of the contribution keeping also the original format (as best as possible, applying only the
changes needed to fit the maintenance report structure and to be compliant with SR 001 262 [3];

. original proposed solution, if any.

NOTE 1: The e-mail threads (mail exchanges) are treated as follows:. every thread is considered as awhole
contribution and the source and date contribution metadata are the ones of the thread's first message. The
messages are time ordered, each message in a different clause, removing the previous thread sequence
from the message body: this way the thread is included in the present document keeping it as compact as
possible, even if this causes |oosing the relations of the message with the thread. Only the first message is
kept both in annex A and clause 5. If this original message has character and paragraph formatting, thisis
preserved; otherwise the Courier font is used.

NOTE 2: In order to respect the privacy, all the personal names have been removed from the maintenance report;
only the name of organizations, bodies and groups are retained.

5 Maintenance tools

5.1 Description of the tools

These tools provide ability to track the elementary comments on several technical specifications (keeping also many
details called "metadata’ as the reference to the original contributions) and record their final resolution. Starting from
the elementary comments stored in a database, these tools can automatically produce the body of the maintenance report
(that can be published as ETSI Technical Report) that documents the current status of comments on the deliverables
being maintained.

Therefore these tools can be used to:

. report to the working group;

. input to experts working on revising specifications;

. publish areport that identifies the status of maintenance activities on ETS| specifications.

Thesetools are:

. an MS access database: the elementary comments are stored in the database using a form,;

. an MSWord template page: using the MS Word mail merge feature applied to the template and using the data
stored in the database, it is possible to create formatted tables that contain the elementary comments and the
related details;

. a set of MSWord macros (written with Visual Basic for Application): is used to manage al steps needed create

the body of the target document (the mai ntenance report), including the mail merge setup, mail merge
launching, finishing the formatting of the mail merge output and to insert it into the target.
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The data and metadata stored in the database for each elementary comment are described in the clause 4.3.2.2. Some
samples of these data and metadata are shown by in annex C. These samples also show the final formatting of the tables
inserted into the ETSI Technical Report, conforming to SR 001 262 [3] and validated by ETS| editHelp! staff. The
toolsin their actual version do not perform any formatting operation on the text within the table cells; therefore
operations as indenting, creating bullets and applying font styles as "bold", "italic" and "underlined”, as shown by the
samples, have to be done manually to fit the requirements of the editHelp! staff.

These tools have been developed to be used by only one user at atime; in fact a database on a file has been used.
Anyway they can be improved in order to be used in a multi-user environment (see clause 6).

5.2 Requirements

These tools require Microsoft Access and Microsoft Word as word processor. These tools have been developed and
tested using the English version of MS Word 2000 and M S Access 2000 both updated with Service Pack 3. The
procedures described in the next clauses refer to the English version of MS Word and M S Access.

5.3 How to install the tools

These tools are packaged in a"zipped" file ("ETSI_maintenance_tools v1.0.zip") that contains the following files:
. "ETS_maintenance.dot": thisfileisaMS Word 2000 template that includes the VBA macros and the toolbar;

. "ETS_maintenance_DB.mdb": thisfileisaMS Access 2000 database for the elementary comments
management;

. "ETS_maintenance_ MM _template.doc": thisfileisaMS Word 2000 document that includes a template for
the Word Mail Merge function; the table included in this template is formatted according to SR 001 262 [3];

. "Readme.txt": this file describes the content of the zipped file and how to install the tools.
In order to install the tools the following steps should be performed:

1) unpack the zipped file into a directory (e.g. "<drive_letter>:\ETS| Maintenance");

2) install the template with the VBA macro only for one MS Word session:
- open the "Tool » Template and Add-Ins" menu;
- click the Add button;
- select the directory "<drive letter>:\ETS| Maintenance" and select the file"ETSI_maintenance.dot";
- check that "ETSI_maintenance.dot” is selected; if not, select it;
- close the dialog box;

3) dternatively install the template with the VBA macro in order to make it available at every MS Word startup:
- open the "Tool » Options' menu;
- select the "File Locations' tab;
- select the row with "File Types' ="Startup”;

- click the "Modify" button to see the full path of the directory containing the templates to be loaded at
every MS Word startup;

- copy the file"ETSI_maintenance.dot" from the directory "<drive letter>\ETS| Maintenance" into the
startup directory (see the previous bullet).
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54 How to use the tools

54.1 Maintenance process and general instructions

As previously mentioned, these tools have been created to support the maintenance process and the generation of the
body of the maintenance report. In order to achieve this goal, the following actions should be performed:

. prepare the maintenance report base file which is a maintenance report (structured as described in clause 4.3)
where the clause 5 contains only the clauses' titles and the placeholders of the tables containing the elementary
comments related to each deliverable (see annex D.2 for a sample of clause 5); the placeholders must be as
follows (respecting the letters' cases and the spacing):

<insert_table name=DELIVERABLE_IDENTIFIER/> (es. <insert_table name=T S101456/>); the
DELIVERABLE_IDENTIFIER must beidentical to the prefix (the part before '-') of the unique
identifier for the elementary comments related to each deliverable (see clause 4.3.2.2 for the rules on
how to generate the comment identifier).

. (tracking stage) complete annex A of the maintenance report base file putting all the contribution received,
assigning the unigque contribution identifier according the rules defined in clause 4.3.2.3 of the present
document and compl eting the contribution metadata (see clause D.4 for a sample of contribution and its
metadata);

NOTE 1: In order to make easier to produce an anonymous maintenance report (needed when published as ETSI
Technical Report) it is necessary to create the unique contribution identifier binding its prefix (the text
string before *-') to the group or the organization the contribution originator belongs to and not to the
originator itself; the detail of the real source originator has to be recorded manually until the
pre-processing stage has been done; in this case is possible to store this piece of information into the
database.

. (pre-processing stage) split every contribution recorded in annex A into elementary comments and insert each
elementary comment into the Mail Merge database (the database structure is described in annex A) as
described in the clause 5.4.2; the meaning of the database fields for the elementary comments is the same as
the fieldsin clause 5 of the maintenance report (see clause 4.3.2.1 for the fields meaning explanation);

NOTE 2: Attention to assign every elementary comment an identifier unique and conforming to the rules explained
inthe clause 4.3.2.2; it isamandatory requirement in order to make the ETSI maintenance tools work
properly when generating the maintenance report.

. (processing stage) if any comment resolution is already available; modify the data and metadata stored in the
Mail Merge database for the proper elementary comments;

. starting from the Mail Merge template (a sample is shown in annex D.1) and the filled Mail Merge database,
generate the maintenance report target file (that is the complete maintenance report) using the procedure
described in clause 5.4.3;

. obtain the complete maintenance report by finishing the maintenance report target file as described in
clause 5.4.4.

Whenever the status of an elementary comments changes, for instance because the comment has been resolved, update
the data and the metadata stored in the Mail Merge database for that el ementary comment; then, if needed, generate an
updated instance of the maintenance report as explained in the last two bullets.

If new contributions are received, the whole sequence described in the present clause can be repeated updating the
mai ntenance base file with the new contribution received (instead of creating a new one as the mentioned sequence
makes provision) and generating, if needed, an updated instance of the maintenance report.

5.4.2 Inserting the elementary comments into the database

To insert or edit the elementary comments into the database, open the file"ETSI_maintenance_DB.mdb" that isan MS
Access database; the insertion form (see figure 1) will be opened automatically. The fields available in the only table
existent in the database and exposed by the insertion form are the same as the one present in clause 5 of the

mai ntenance report, except for two fields. Therefore the meaning of the matching fields is described in clause 4.3.2.2.
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The insertion form exposes two more fields not present in clause 5 of the maintenance report. They are
"anonym_contrib_source" and "anonym _resolution_source" and serve to make the maintenance report anonymous for
the purpose of publication as ETSI Technical Report while the real details of the contribution and resolution sources are
retained within the database.

The Mail Merge template included as samplein clause D.1 is designed to generate the maintenance report asETSI
Technical Report; therefore it binds the clause 5 fields to the Word Mail Merge fields present in the Mail Merge
template. The clause 5 fields are represented by the column text in the header of the table included in the Mail Merge
template. The Word mail Merge fields are made available from the database by the Word Mail Merge feature and are
also exposed by the insertion form. The mentioned binding is straightforward for all fields except for the one, as
follows.

Table 1

Clause 5 field names |Mail Merge Word field names
Resolution source «anonym_resolution_source»

If there isthe need to generate an instance of the maintenance report for internal purposes (without the need to make it
anonymous), isit possible to modify the Mail Merge template by adding for instance some new fields and binding the
clause 5 fields to the Word Mail Merge fields as follows.

Table 2
Clause 5 field names Mail Merge Word field name
Anonymous contribution source |«anonym_contrib_source»
Real contribution source «contrib_source»
Anonymous resolution source  |«anonym_resolution_source»
Real resolution source «resolution_source»

Examples of values for the fields listed in the previous table are given in table 3.

Table 3
Example n. |Mail Merge Word field names Values
1 «anonym_contrib_source» TC ESI member
2 «anonym_contrib_source» STF 999 - Task 15 member
3 «anonym_contrib_source» New Company inc.
4 «contrib_source» John Doe (TC ESI)
5 «contrib_source» John Doe (STF 999 - Task 15)
6 «contrib_source» John Doe (New Company inc.)
7 «anonym_resolution_source» |TC ESI member
8 «anonym_resolution_source» |STF 999 - Task 15 member
9 «resolution_source» John Doe (TC ESI)
10 «resolution_source» John Doe (STF 999 - Task 15)

Thereal contribution source is a valuable piece of information to be retained because makes who performed the
comment resolution able to reply to the contribution originator even much time later after the receipt of the
contributions); similarly the real resolution source detail let identify who resolved the comment even much time after
the comment resolution.

To manage the database records (add, delete, move to, etc.), the standard M S Access functions (buttons and menus)
have to be used.

In order to successfully launch the Mail Merge operation as explained in the next clause, there is the need to fill in at
least the following database fields for each elementary comment:

. "comment_ID", the primary key of the database table (see annex A for further details);
. "elem_comment_type", choosing among the val ues available from the combo box;

. "resolution_status"’, choosing among the val ues available from the combo box.
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Figure 1: elementary comments insertion form

5.4.3  Creating the body of the maintenance report
To create the body of the maintenance report, launch MS Word and make sure that only the default blank document is

open; then click the "ETSI Maintenance" button on the toolbar: the main menu for the maintenance report creation will
be shown (see figure 2 for asample).
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Figure 2: menu for maintenance report creation

Then the following actions should be done:

type the full path of the Mail Merge template or select it by clicking the"MS Word Mail Merge Template"
button; the default Mail Merge template is"ETSI_maintenance_ MM _template.doc”, included in the tools
package and was validated by editHelp! staff; anyway it is possible to modify it or to create a new one;

type the full path of the Mail Merge database that contains the elementary comments or select it by clicking
the "MS Access Mail Merge DB" button; the default Mail Merge database is"ETSI_maintenance_DB.mdb",
included in the tools' package; anyway it is possible to modify it or to create a new one; the requirements to
comply with when creating a new database are that a query called "qComments" must exists and must return at
|east one record;

click the " Setup Mail Merge and edit" button to setup the MS Word Mail Merge function: the Mail Merge
template will be loaded and shown; at this stage the user can modify the template, adding, modifying or
removing text, Mail Merge and Word fields (by clicking the proper buttons present on the toolbars); if any of
the mentioned text boxes are empty, an error message box is shown; if the Mail Merge template does not exist
the user is asked if he wanted to continue creating a new template or not; if the Mail Merge database does not
exist an error message box is shown;

click the "ETSI Maintenance" button on the toolbar to show again the main menu;

click the "Start Mail Merge" button to start the Mail Merge operation; the outcome of these operation will be
document named " Catalogl" with the result of the mail merge and optionally an error window;

close any open document but the one named "Catalogl" and save the Mail Merge template if needed;
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type the full path of the maintenance report base file or select it by clicking the "M S Word report base file"
button; this document includes the placeholders (see clause D.1) and serves as basis for the generation of the
mai ntenance report;

type the full path of the maintenance report target file or select it by clicking the "M S Word report target file"
button; this will be a new document obtained by substituting the placeholders with the tables including the
elementary comments for each deliverable (one table for each deliverable);

click the "Format MM output, copy, save" button to start the macro that format properly the tables produced
by launching the Mail Merge by joining the tables of the elementary comments related to each deliverableinto
asingle table; then this macro will copy the tablesin place of the placeholders included in the maintenance
report base file and will save the result (maintenance report target file) with the specified name; if any of the
mentioned text boxes is empty, an error message box is shown; if the maintenance report base file does not
exist, an error message box is shown; if the maintenance report target file already exists the user is asked if he
wanted to continue overwriting the existent file or not; while running, the Word window is minimized in order
to increase the speed of the operation; two message box are shown, one telling the user that the first part of the
macro (formatting) is ended and the other one telling the user that second part of the macro (copying) is ended:
the macro is terminated;

click the "Close" button to close the main menu;

close the "Catalogl" window without saving the document; it served as intermediate output and it won't be
useful anymore;

when MS Word will be closed, it is possible that a dialog box is shown asking the user to retain the data
present in the Windows Clipboard; it is suggested to clean the Windows Clipboard selecting the "No" choice.

Finishing the maintenance report

In order to obtain the final maintenance report, some actions should be done over the maintenance report target file
produced by the ETSI maintenance tools:

5.5

5.5.1

the actual ETSI maintenance tools do not perform any formatting operation on the text within the table cells;
therefore operations as indenting, creating bullets and applying font styles as "bold", "italic* and "underlined"
have to be done manually to fit the requirements of the editHelp! staff (see clause D.3);

some elementary comments may be so long that they do not fit a single page; in this case the table cell
containing the elementary comment is automatically enlarged to fit the page and the text in excess; in order to
revolve this problem there is the need to manually split the text of the elementary comments into a number of
pieces to be put each one in a separate;

in order to minimize the growth of the maintenance report, especially when published as ETSI Technical
Report, the elementary comments resolved are retained only in the first issue of the maintenance report after
their resolution, then they will be removed (see clause 4.3.2.2); the actual ETS| maintenance tools do not have
the capability to support this assumption; therefore there is the need to manually remove the resolved
comments in the maintenance report subsequent to the first one issued after they have been resolved.

How the tools work

Mail Merge database

Itisan MS Access database whose structure is described in annex A. In order to be used successfully as data source for
the Mail Merge feature as managed by the ETSI maintenance tools, a query caled "gComments' must exist within the
database. This query must return the records ordered by comments' identifier in order to make the macro generating the
mai ntenance report target file work properly (see clause 5.5.3).
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5.5.2 Mail Merge Word feature and template

To extract the data and the metadata of each elementary comment and properly format the extraction result, the Mail
Merge feature provided by has been chosen. After having chosen a data source (in this case the Mail Merge database)
and having created a template with the Mail Merge fields, provided by the data source, the launch of this feature
produce automatically a new document where the content of the template is repeated as many times as the number of
the record provided by the data source and the Mail Merge fields are replaced by the corresponding value for each
record.

In order to simplify the use of this feature, its use is managed through the main menu for the report creation (see
clause 5.4.3). The macro that setup the Mail Merge feature lets the user choose the data source (the Mail Merge
database) and the Mail Merge template, but it requires that a query called "qgComments" exists within the database and
return the records with the proper fields needed to fill in the Mail Merge template.

In order to be successfully used with the ETSI maintenance tools, the template shall include a Word paragraph before
the table containing the Mail Merge fields and another one after.

Thisway the outcome of the Mail Merge operation will be is a document, named "Catalogl", containing many tables,
one for each elementary comment returned by the data source. The tables are separated by one Word paragraph.

5.5.3 Macro producing the maintenance report target file
Two parts constitute the macro that generates the maintenance report target file:

. the first one operates over the outcome of the Mail Merge operation (the document named "Catalogl") and
join together the tables of the elementary comments related resulting in a number of tables same as the number
of the deliverables maintained,

. the other one copies each table present in the "Catalogl" replacing the corresponding placeholder present in
the maintenance report base file and save the file as the maintenance report target file.

Thefirst part of the macro infers the deliverables, which the elementary comments are related to from comments
identifiers. Therefore, in order to make the macro work properly, the comments' identifiers stored into the Mail Merge
database must respect the rules defined in clause 4.3.2.2. Moreover all the elementary comments related to asingle
deliverables must be contiguous; this must be guaranteed by the data source used to perform the Mail Merge operation.

Thelist of the deliverables generated by the first part isinternally stored while the macro is running and is used by the
second part of the macro; the deliverables' identifiers within the placehol ders present in the maintenance report base file
must be identical to the ones present in that internal list and constituted by the prefixes of the comment identifiers (see
clause 4.3.2.2). Moreover the placeholders must be compliant with the format described in clause 5.4.1.

NOTE: When the macro is running, no error will be returned if trying to copy atable the placeholder was not
found. Simply the table related to a deliverable won't be present within the maintenance report target file
without any advice being returned to the user.

5.6 Generalized use of the maintenance tools

The tools have been developed to support the maintenance process and to generate the maintenance report as described
but they can also be used to generate documents with different purposes. In particular the Mail Merge database and the
Mail Merge template can contain any data type (not necessarily elementary comments) and to be managed through the
menu for maintenance creation report there is only the need for the query named "qComments' stored in the database.

Instead, in order to make the formatting and copying macro work properly, al the constraints described in clause 5.5
must be respected.
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6 Tools improvements

6.1 Adding some automatic formatting capabilities

Asexplained in clause 5.4.4, the actual ETSlI maintenance tools do not perform any formatting operation on the text
within the table cells. Some useful features can be added to the tools in order to perform automatically operations as
indenting, creating bullets and applying font styles as "bold”, "italic" and "underlined" to fit the requirements of the
editHelp! staff (see clause D.3).

Since the elementary comments are stored in the database within the MS Access "memo" fields, only text can be stored.
Therefore a hint to adding the automatic formatting capabilitiesisto use tag similar to the HTML ones to enclose the
pieces of text that need to be formatted. Then the formatting and copying macro should be modified to recognize the
formatting tags, remove them and apply the proper formatting element or style to the enclosed text.

Furthermore, the database insertion form could be modified to make easier the insertion of these formatting tags.

6.2 Improving the database structure

The actual Mail Merge database is not normalized; therefore there is the need to input redundant data while inserting the
elementary comments: for instance the contribution source and date, etc. The database normalization will increase the
number of the tables and the database complexity but will avoid the need to insert many times the same data.

Moreover such an improvement makes al so possible to manage the insertion of the contribution metadata into the
database while filling the annex A of the maintenance report and not later, avoiding aso the need to track manually the
anonymous data.

6.3 Improving the database insertion form

After having improved the database structure, it is possible to modify the insertion form in order to speed-up the input
of the elementary comments related to the same deliverable and to speed-up the assignment of values to multiple
comments.

6.4 Making the tools corporate

Asexplained in clause 5.1, these tools in the actual version have been designed to be used by only one user at atime.
Anyway they could be modified to support a multi-user and corporate environment. In order to do that some suggestion
isgiven:

. the use of a centralized server database engine for corporate instead of a database on afile; this would enable
the tools:

- to give the experts resolving the comments a concurrent access to the database;
- to be used by all technical committees each one maintaining their set of deliverables;

- to give the users of deliverables the opportunity to become aware of the ongoing maintenance activity
performed over those deliverables through a web based application;

. implementing the insertion form through a dedicated application supporting the visual formatting of the
elementary comments data or through a web based form;

. extending the tools to support arange of versions of MS Word and Access (for instance from 97 to 2003).
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Annex A:
Database structure

Al Tables

A.1.1 Table "tComments"

A.1.1.1 Columns

Table A.1

Name Type Size
deliverable_type Text 2
deliverable ID Text 50
deliverable version Text 10
deliverable section Text 15
comment_ID Text 12
orig_contrib_reference Text 12
contrib_source Text 50
anonym_contrib_source Text 50
contrib_date Date/Time 8
elem_comment_type Text 50
elem_comment_text Memo -
orig_resolution proposal Memo -
resolution_source Text 50
anonym_resolution_source Text 50
resolution_date Date/Time 8
resolution_comment Memo -
resolution_text Memo -
resolution_status Text 20
deliverable target version Text 15

A.1.2 Table "tCommentType"

A.1.2.1 Columns

Table A.2
Name Type Size
CommentTypelD Text 4
CommentType Text 20
A.1.2.2 Predefined records
Table A.3
CommentTypelD CommentType
EDIT editorial
TECH technical
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A.1.3 Table "tResolutionStatus”

A.1.3.1 Columns

Table A.4
Name Type Size
ResolutionStatusID Text 4
ResolutionStatus Text 25
A.1.3.2 Predefined records
Table A5
ResolutionStatusID ResolutionStatus
ALAP already applied
APPL applied
INPR in process
NOCH no change
NYPR not yet processed
PRAP provisionally approved

A.2  Relationships' diagram

e lverenl=_ [0
e verahba_weraion
el lverable_section TV
jeomment I = | CommentTypell
orig_ontrib_refererce CorniertTyme
COririD_S0Uoe
arorym _coriros sore
coririo_date _/’
e lam_pomment_bype =

= am_oomment_test

i _resolution proposs
esnbbon_source
laroryn _resal_tion_sounce
wsahtion_date 1
e b bon _oormrnent
e b o et

wanltion_ctsn s ='F/
etiveranike_Eroel_wverdion

Figure A.1: Tables relationship
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A.3  Queries

Only the query named "gComments' is present in the database. The MS SQL source for the query is:

SELECT t Comments. del i verabl e_type, tComrents. deliverable_ID, tComrents.deliverable_version,

t Corment s. del i verabl e_section, tComments.comment _| D, tComments.orig_contrib_reference,

t Comrent s. contri b_source, tComrents.anonymcontrib_source, tComrents.contrib_date,

t Comment Type. Corment Type, t Comments. el em comment _text, tComments.[orig_resolution proposall],

t Comment s. resol uti on_source, tComments.anonymresol ution_source, tComments.resol ution_date,

t Comment s. resol uti on_conment, tComments.resolution_text, tResolutionStatus. Resol utionStatus,

t Comment s. del i ver abl e_t arget _version

FROM t Resol utionStatus I NNER JO N (t Conment Type | NNER JO N t Conments ON t Comment Type. Comment Typel D =
t Comment s. el em comment _type) ON t Resol uti onStatus. Resol utionStatusl D = t Conments. resol uti on_status
ORDER BY t Comment s. comment _| D
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Annex B:
MS Word global template: macros' VBA sources and forms

B.1 VBA sources

B.1.1 Module "modCode"

ETSI maintenance tool v. 1.0 - 14 March 2004
for M5 Wrd 2000 SP3

devel oped by G anluca Ramunno (Politecnico di Torino) for ETSI

Copyri ght European Tel econmuni cations Standards Institute 2004

force the variables' declaration
Option Explicit

Sub StartETSI Mai nt enanceTool ()
f r mvenu. Show
End Sub

Sub For mat MMQut put (parBase As String, parTarget As String)

Dim | As |nteger

Di m keyword As String
DimlistID(30) As String

Di m storedl D As | nteger
DimtargetNane As String

Di m sour ceDoc As Docunent

Di m t arget Doc As Docunent

Di m sour ceDocW ndowsSt ate As Long
Di m t ar get DocW ndowsSt ate As Long

"keyword definition to search the header row of the tables
keyword = "Comment |D"

'counts the nunber of deliverables IDs stored inthe 'listlD array
storedlD = 0

Set sourceDoc = ActiveDocunent

save the current status and nminimze the windows to inprove the performances
sour ceDocW ndowsSt at e = sour ceDoc. Acti veW ndow. W ndowsSt at e
sour ceDoc. Acti veW ndow. W ndowSt at e = wdW ndowSt at eM ni mi ze

go to the beginning of the docunment
Sel ecti on. HomeKey Unit:=wdStory

start the search | oop
Do

set not to search for any formatting item
Sel ection. Find. Cl ear Formatting

set the search paraneters
Wth Sel ection.Find
. Text = keyword
. Repl acenent . Text = ""
.Forward = True
.Wap = wdFindStop ' the search ends when reaching the end of the docunent
.Fornmat = Fal se
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. Mat chCase = True
. Mat chWhol eword = Fal se
. Mat chW | dcards = Fal se
. Mat chSoundsLi ke = Fal se

. Mat chAl | Wor dFor s = Fal se
End Wth
' search execution
If Selection.Find Execute =
' string ' Conment

Fal se Then

Exit Do
End |f
' go down of one row. go to the cell with data
Sel ecti on. Move wdRow, 1
' Sel ecti on. MoveDown Unit: =wdLi ne, Count:=1

' select the whole cell
Sel ecti on. Sel ect Cel |

' cone back of one char to skip the cell narker
Sel ection. MoveEnd Unit:=wdCharacter, Count:=-1
' MsgBox Sel ection.Text + " " + GetDocld(Sel ection. Text)

I f GetDocld(Selection.Text) = listlD(storedl D) Then

this comrent
' therefore the tables have to be joint

ID not found (reached the end of the doc.
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or string not present

is related to the sanme deliverable as the previous one,

' go to the row just above (rmoving of one row only unselects the cell:

' the second novenent is the real one)
Sel ecti on. Move wdRow, -2

' goto the line just above the table

Sel ecti on. MoveUp Unit: =wdLi ne, Count:=1

go to the beginnging of the line
Sel ecti on. HomeKey Unit: =wdLi ne

' go to the end of the line selecting the line itself

Sel ecti on. EndKey Unit: =wdLi ne, Extend: =wdExt end

"delete the line (and join the tables)
Sel ection. Del ete Unit:=wdCharacter, Count:=1
' go to the previous position
Sel ecti on. Move wdRow, 1

El se

' this comment is related to the new deliverable,

therefore the tables

' have to remain disjoint and the deliverable ID has to be stored

storedlD = storedlD + 1
listlD(storedl D) = GetDocld(Sel ection. Text)

If storedlD > 1 Then ' there is at

| east one table conpleted

' go to the row just above (nmoving of one row only unselects the cell:

' the second novenent is the real

Sel ecti on. Move wdRow, -2

one)

' go to the |ast
' separes the tables

Sel ecti on. MoveUp Unit: =wdLi ne, Count:=2

sel ect the table where the insertion point
If Selection.|nfornation(wdWthlnTable) Then
' select the table where the insertion point

Sel ecti on. Tabl es(1). Sel ect

isin

isin

line of the previous table (supposing that only one |line

' add a bookmark (for the selected table) naned as the deliverable ID
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Acti veDocunent . Booknmar ks. Add Nane: ="_ETSI _frnt_" + listlD(storedlD - 1),
Range: =Sel ect i on. Range

End |f

go to the two lines belowthe table (the first line of the next table)

Sel ecti on. MoveDown Unit:=wdLi ne, Count: =2

' go to the previous position (second row)
Sel ecti on. Move wdRow, 1

El se

Sel ecti on. HomeKey Uni t: =wdLi ne

End |f

End | f
Loop

If storedlD = 0 Then
' keyword (e.g. 'Comment ID) string not found: missed tables or not properly filled. The
macro will end
MsgBox "string + keyword + not found: missed tables or not properly filled. The macro
will end!'", vbOKOnly + vbExcl amation, "Macro End"
Exit Sub
El se

sel ect the table where the insertion point is in
I f Selection.|nfornation(wdWthlnTable) Then
' select the table where the insertion point is in
Sel ection. Tabl es(1). Sel ect
' add a bookmark (for the selected table) naned as the deliverable |ID
Acti veDocunent . Booknmar ks. Add Nane: ="_ETSI _frnt_" + listlD(storedl D),
Range: =Sel ect i on. Range

End |f
End | f

MsgBox "Mail Merge output fornatted - starting copying to target docunent", vblnfornation

copy and paste the tables (one for each deliverable) in the target document

target Name$ = par Base
' open the file of the target docunent

Set targetDoc = Docunents. Open(target Nane$)
' save the current status and mininmze the windows of the target doc to i nprove the perfornmances
target DocW ndowsSt at e = Acti veDocunent . Acti veW ndow. W ndowSt at e

target Doc. Acti veW ndow. W ndowSt at e = wdW ndowSt at eM ni mi ze

For | =1 To storedlD
I f ActiveDocunent. Booknarks. Count >= 1 Then

activate the source docunent (the one just formatted)
sour ceDoc. Activate
' select a table through its bookmark
Acti veDocunent . Bookmar ks(" _ETSI _frmt_" + listID(l)). Sel ect
' copy the table in the clipboard
Sel ect i on. Copy
' activate the target docunent
target Doc. Activate
' set not to search for any formatting item
Sel ection. Find. G ear Formatting
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Wth

. Text

the search paraneters
Sel ection. Find

.Forward = True
.Wap = wdFi ndCont i nue

end of the docunent

. For mat
. Mat chCase

Fal se
True

. Mat chWhol eword = Fal se

. Mat chW | dcar ds
. Mat chSoundsLi ke

Fal se
Fal s

e
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= "<insert_table name=" + listID(l) + "/>
. Repl acement . Text

since the position of the searched text

the search continues

. Mat chAl | Wor dForns = Fal se
End Wth

search execution
I f Sel ection. Find. Execute
ID not found (reached the end of the doc.

string ' Conment

Sel ecti on. Past e

End |
End | f

Next |

target Doc. Act

Act i veDocunent . SaveAs Fi | eName: =par Tar get ,
, LockComment s: =Fal se,

Wi tePass

f

i veW ndow. W ndowsSt at e

wor d: =

Password: = _
ReadOnl yReconmended: =Fal se, EnbedTrueTypeFonts: =Fal se,

SaveNat i vePi ct ur eFor mat : =Fal se,

Fal se

MsgBox " Target docunent saved - end of nmcro", ,

End Sub

True Then

AddToRecent Fi | es:

SaveFor nsDat a: =Fal se,

vbl nf ormati on

Function Get Docl d(par Corment | D As Stri ng)

Dim1 As Long

For 1 =1 To
If Md$(p
Exi t
End | f
Next |

Len( par Comment | D)
arComrent | D, |, 1)
For

GetDocld = Trind(Left$(par Comment | D,

End Function

Sub Set upMai | Mer ge( par Mai | MergeBase As String,

Dimfs As Obj

ect

Then

I - 1))

par Mai | Mer geDB

Set fs = CreateOhject("Scripting.FileSystenObject")

If fs.FileExi

st s(par Mai | Mer geBase)

Fal se Then

Docunent s. Add Docunent Type: =wdNewBl ankDocunent

Acti veDocunent . SaveAs Fi | eNane: =par Mai | Mer geBase,

LockComme

SaveNati v
Fal se

El se

nts: =Fal se, Password: =

ePi ct ur eFor mat : =Fal se,

ReadOnl yRecomended: =Fal se,

File

SaveFor nsDat a: =Fal se,

Docunent s. Open Fi | eNane: =par Mai | Mer geBase,

Confir mCo

Passwor dDocunent :
Wit ePasswor dDocunent :

wdQpenFor
End | f

nver si ons: =Fal se,

mat Aut o

ReadOnl y: =Fal se,
Passwor dTenpl at e:
Wi tePasswordTenpl ate: =

Revert: =Fa
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i s unknown
from the begi nning when reaching the

or string not present

restore the w ndow status of the source and target docunents
sour ceDoc. Acti veW ndow. W ndowSt at e = sour ceDocW ndows St at e
t ar get DocW ndows St at e

Fi | eFor mat : =wdFor mat Docunent

=True,

SaveAsACCELetter:= _

Search for the separator between deliverable |D and comment nunber

As String)

For mat : =wdFor mat Docunent ,

, AddToRecent Fil es: =True, WitePassword _
EnbedTr ueTypeFont s: =Fal se,

SaveAsAOCELet ter: = _

“AddToRecent Fi | es: =Fal se,

I se, _
Format: = _
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W ndows( par Mai | Mer geBase) . Acti vate

Act i veDocunent . Mai | Mer ge. Mai nDocunent Type = wdCat al og

Acti veDocunent . Mai | Mer ge. OpenDat aSour ce Name: =par Mai | Mer geDB, _
Confi rmConver si ons: =Fal se, ReadOnl y: =Fal se, LinkToSource: =True, _
AddToRecent Fi | es: =Fal se, PasswordDocunent:="", PasswordTenpl ate: ="",
Wit ePasswor dDocunent: ="", WitePasswordTenpl ate: ="", Revert:=Fal se, _
For mat : =wdOpenFor nat Aut o, Connecti on: =" QUERY qComment s", SQL.Statenent:= _
"SELECT * FROM [ gComrents]", SQ.Statenentl:=""

Acti veDocunent . Mai | Mer ge. Edi t Mai nDocunent

End Sub
Sub StartMil Merge(parMai | MergeBase As String, parMil MergeDB As String)

Wth ActiveDocunent. Mai | Merge
. Destination = wdSendToNewDocurent
. Mai | AsAttachnent = Fal se
. Mai | Addr essFi el dNane = ""
. Mai | Subj ect = ""
. Suppr essBl ankLi nes = True
Wth . DataSource
. FirstRecord = wdDef aul t Fi rst Record
. Last Record = wdDef aul t Last Record
End Wth
. Execut e Pause: =Fal se
End Wth

End Sub

B.1.2 Module "frmMenu"

ETSI mai ntenance tool v. 1.0 - 14 March 2004
for M5 Wrd 2000 SP3

devel oped by G anl uca Ramunno (Politecnico di Torino) for ETSI

Copyri ght European Tel econmuni cati ons Standards |Institute 2004

Private Sub cndFor mat MMOut put _d i ck()

Dimfs As Object
Di m response As | nteger

Set fs = CreateOhject("Scripting.FileSystenObject")
If fs.FileExists(Trins(txtBase.Text)) = Fal se Then
MsgBox "The file " + Chr$(34) + Trin®(txtBase. Text) + Chr$(34) + " doesn't exist!" _
+ Chr$(10) + Chr$(10) + "Select an existent file.", vbCritical
Exit Sub
El self fs.FileExists(Trind(txtTarget. Text)) = True Then
response = MsgBox("The file " + Chr$(34) + Trin®(txtTarget.Text) + Chr$(34) + " already
exists!" +
Chr$(10) + Chr$(10) + "Do you want to start the procedure to produce the target docunent
that will overwite the existent the file?", vbQuestion + vbYesNo)
I f response = vbNo Then
Exit Sub
End | f
End | f
Me. MousePoi nter = fmvbusePoi nt er Hour G ass
For mat MMOut put Tri n$(t xt Base. Text), Trin®(txtTarget. Text)
Me. MousePoi nter = fmvbusePoi nt er Def aul t

End Sub

Private Sub cndC ose_Qick()
Unl oad Me

End Sub

Private Sub cndSel ect Base_O i ck()
Wth D al ogs(wdDi al ogFi | eQpen)
.Nane = "*.doc"
. Di spl ay
If Trin®(.Nane) <> "*.doc" Then
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" Ful | NameOf Doc = Repl aceW't hi n( Ful | NameOf Doc, Chr(34), "") ' Requires the
Repl aceW t hi n Function
Ful | NaneO&fDoc = CurDir & "\" & . Nane
t xt Base. Text = Ful | NaneOf Doc
' MsgBox t xt Base. Text
End | f
End Wth

End Sub

Private Sub cndSel ect Mui | MergeBase_d i ck()
Di m Ful I NaneOf Doc As String

Wth D al ogs(wdDi al ogFi | eQpen)

.Name = "*_ doc"
. Di spl ay
If Trin®(.Nane) <> "*.doc" Then
" Ful | NameOrf Doc = Repl aceW t hi n( Ful | NameOf Doc, Chr(34), "") ' Requires the

Repl aceW t hi n Function
Ful | NaneOf Doc = CurDir & "\" & . Nane
t xt Mai | Mer geBase. Text = Ful | NaneOf Doc
' MsgBox t xt Mai | Mer geBase. Text
End | f
End Wth

End Sub

Private Sub cndSel ect Mai | MergeDB_O i ck()
Di m Ful  NaneOf DB As String

Wth D al ogs(wdDi al ogFi | eQpen)
.Name = "*. mdb"

. Di spl ay
I'f Trin®(.Nane) <> "*.mdb" Then
" Ful | NameOrf Doc = Repl aceW't hi n( Ful | NameOf Doc, Chr(34), "") ' Requires the

Repl aceW t hi n Function
Ful INaneO'DB = CurDir & "\" & . Nane
t xt Mai | Mer geDB. Text = Ful | NameCOf DB
' MsgBox t xt Mai | Mer geDB. Text
End | f
End Wth

End Sub

Private Sub cndSel ect Target _C i ck()
Di m Ful | NameOf Doc As String

Wth D al ogs(wdDi al ogFi | eQpen)

. Narme = "*, doc"
. Di spl ay
If Trin®B(.Nane) <> "*. doc" Then
" Ful | NameOrf Doc = Repl aceW't hi n( Ful | NameOf Doc, Chr(34), "") ' Requires the

Repl aceW t hi n Function
Ful | NaneOfDoc = CurDir & "\" & . Nane
txt Target. Text = Ful | NaneOf Doc
' MsgBox txt Target. Text
End | f
End Wth

End Sub

Private Sub cndSet upMv d i ck()
Dimfs As Object
Di m response As | nteger

Set fs = CreateObject("Scripting.FileSystenObject")
If fs.FileExists(Trin®(txtMilMergeBase. Text)) = Fal se Then

response = MsgBox("The file " + Chr$(34) + Trins(txtMil MergeBase. Text) + Chr$(34) + "
doesn't exist!" _
+ Chr$(10) + Chr$(10) + "A new enpty Mail Merge tenplate will be created with the sane file
nane. Do you want to proceed", vbQuestion + vbYesNo)
I f response = vbNo Then
Exit Sub
End | f

El self fs.FileExists(Trind(txtMilMergeDB. Text)) = Fal se Then
MsgBox "The file " + Chr$(34) + Trin®(txtMil MergeDB. Text) + Chr$(34) + " doesn't exist!",
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Chr$(10) + Chr$(10) + "Select an existent file.", vbCritical
Exit Sub
End | f

Me. MbusePoi nt er = fnivbusePoi nt er Hour A ass

ETSI TR 102 317 V1.1.1 (2004-06)

Set upMai | Merge Tri n(txt Mai | MergeBase. Text), Trin®(txtMil MergeDB. Text)

cndSt art MM Enabl ed = True
Me. MousePoi nter = fmvbusePoi nt er Def aul t

End Sub

Private Sub cndStart MM Qi ck()
Me. MousePoi nter = fnmvbusePoi nt er Hour G ass

Start Mai | Merge Trin(txtMail MergeBase. Text), Trin®(txtMil MergeDB. Text)

Me. MousePoi nter = fmvbusePoi nt er Def aul t
End Sub

Private Sub cndlnfo_dick()
frm nfo. Show
End Sub

Private Sub txtMil MergeBase_Change()

I'f Trin®(txtMil MergeBase. Text) <> "" And Trin®(txtMil MergeDB. Text) <> "" Then

cmdSet upMM Enabl ed = True

El se
cndSet upMM Enabl ed = Fal se
End | f
End Sub

Private Sub txtMil MergeDB_Change()

I'f Trin®(txtMil MergeBase. Text) <> "" And Trin®(txtMil MergeDB. Text) <> "" Then

cmdSet upMM Enabl ed = True

El se
cndSet upMM Enabl ed = Fal se
End | f
End Sub

Private Sub txtBase_Change()
If Trin®(txtBase. Text) <> "" And Trin®(txtTarget.Text) <> "" Then
crmdFor mat MMQut put . Enabl ed = True

El se
cndFor mat MMQut put . Enabl ed = Fal se
End | f
End Sub

Private Sub txtTarget _Change()
If Trins(txtBase. Text) <> "" And Trind(txtTarget.Text) <> "" Then
cmdFor mat MQut put . Enabl ed = True

El se
cndFor mat MMQut put . Enabl ed = Fal se
End | f
End Sub

B.1.3 Module "frmiInfo"

ETSI mai ntenance tool v. 1.0 - 14 March 2004
for M5 Wrd 2000 SP3

devel oped by G anl uca Ramunno (Politecnico di Torino) for ETSI

Copyri ght European Tel ecomruni cati ons Standards Institute 2004

Private Sub cndC ose_Oick()
Unl oad Me
End Sub
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B.2 VBA forms

B.2.1 Form "frmMenu"

ETSI - Maintenance Tools #|
1) Select the files for Mail Merge
ME Ward
Mai| Marge
tamplats
<13 Accass
Ml Merge
&)

2) Setup Mail Mermge and optionally add DNelds

3) Start Mail Merge

4) Select the files for the report creation

5) Format Mail Merge output, copy and save as target

i .
jm i | <

Figure B.1
B.2.2 Form "frminfo"
Info

ETSI Maimtenance Toals v, 1.0
by Serbum Famunno ke ETS1 - Teandy 2000

Figure B.2
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Annex C:
How to recreate the tools

C.1 Introduction

This annex describes how to recreate the ETS| maintenance tools having available only the present document. The mail
Merge database, the VBA macros and the Mail Merge template are taken into account. In order to make easy recreate
the tools the components have to be recreated in the order they have presented in clause C.2.

C.2 Procedures for maintenance tools recreation

C.2.1 Mail Merge database

In order to recreate the Mail Merge database, the following steps have to be done:
. launch M'S Access and create a blank database named "ETSI_maintenance DB.mdb";
. create a new table named "tComments' according to clause A.1.1;

. create a new table named "tCommentType" according to clause A.1.2.1 and create the predefined records as
shownin clause A.1.2.2;

. create a new table named "tResolutionStatus" according to clause A.1.3.1 and create the predefined records as
shown in clause A.1.3.2;

. set the relationship among the tables as shown in clause A.2;
. create the query "gComments" as shown in clause A.3;

. create the insertion form "fComments' as shown in clause 5.4.2, including all the fields present in the
"tComments' table.

C.2.2 VBA macros

In order to recreate the VBA macros, the following steps have to be done:
. launch MS Word and make sure that only the default blank document is open;
. open the Visual Basic editor (open the "Tool » Macro® Visual Basic Editor" menu);

. right click the "Project (Document1)" line for the current blank document in the "Project” panel and select
"Project Properties’: change the VBA project name from "Project” to "ET SIMaintenance”" and click the "OK™
button;

. right click the "ET SIMaintenance (Document1)"” line for the current blank document in the "Project” panel and
select " Insert » UserForm": change the form name in the " Properties® panel from "UserForm1" to "frmMenu”
and create aform as shown in clause B.2.1;

. right click the "frmMenu" line for the form just created in the "Project” panel and select "View code" and in
the blank editor copy the VBA code present in clause B.1.2;

. right click the "ETSIMaintenance (Document1)" line for the current blank document in the "Project" panel and
select " Insert » UserForm™: change the form name in the "Properties’ panel from "UserForm1" to "frminfo"
and create aform as shown in clause B.2.2;
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right click the "frminfo” line for the form just created in the "Project” panel and select "View code" and in the
blank editor copy the VBA code present in clause B.1.3;

right click the "ETSIMaintenance (Document1)" line for the current blank document in the "Project" panel and
select "Insert » Module": change the form name in the " Properties’ panel from "Modulel" to "modCode" and
in the blank editor copy the VBA code present in clause B.1.1;

click the "File» Save" menu: select a proper directory where save the file, then select "Document Template
(*.dot)" inthe "Save as type" combo box and type "ETSI_maintenance.dot" in the "File name" combo box;

close the Visual Basic Editor and close MS Word.

C.2.3 Mail Merge template

In order to recreate the Mail Merge template, the following steps have to be done:

install the tool "ETSI_maintenance.dot" as described in clause 5.3;
launch MS Word and make sure that only the default blank document is open;

click the "ETSI Maintenance" button on the toolbar: the main menu for the mai ntenance report creation will be
shown (see figure 2 for a sample).

type the full path of the Mail Merge template to be created select it by clicking the "M S Word Mail Merge
Template" button, choosing the name or "ETSI_maintenance MM _template.doc";

type the full path of the empty Mail Merge database ("ETSI_maintenance_DB.mdb") or select it by clicking
the "M S Access Mail Merge DB" button; the default Mail Merge database is, included in the tools' package;

click the "Setup Mail Merge and edit" button to setup the MS Word Mail Merge function: the user is asked for
anew template creation; clicking the"Yes" button, the empty Mail Merge template will be loaded and shown;

at this stage the user can modify the template, adding, modifying or removing text, Mail Merge and Word
fields (by clicking the proper buttons present on the toolbars);

create atabled layout as shown in clause D.1 using the ETSI styles for table formatting;
click the"ETSI Maintenance" button on the toolbar to show again the main menu and click the "close" button;

save the "ETSI_maintenance_ MM _template.doc" document and close Word.
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Annex D:
Mail Merge template and maintenance report samples

This annex includes some examples of the maintenance report base file and of the maintenance report as outcome of the Mail Merge operation and the application of VBA
macro included among the ETSI mai ntenance tools.

D.1

Sample of Mail Merge template

Table D.1 represents a sample of a Mail Merge template. In particular thisis the template used to generate the updated TC ESI maintenance report (TR 102 046 [2]). Examples
of the Mail Merge outcome obtained using this template are shown in clause D.4. The Mail Merge fields present in the table cells are the ones available when using the ETSI
mai ntenance database (or Mail Merge database) as MS Word Mail Merge data source.

Table D.1
Comment ID | Deliverable | Deliverable Original Comment Comment Resolution Resolution Resolution status Deliverable target
version clause contribution date type source date version
reference
«comment_ID» |«deliverable |«deliverable_ |«orig_contrib_refer |«contrib_dat |«CommentT |«anonym_resol |«resolution_dat |«ResolutionStatus» |«deliverable_target_ve
version» section» ence» e» ype» ution_source» |e» rsion»
Comment |«elem_comment_text»
text
Original «orig_resolution_proposal»
resolution
proposal
Resolution |«resolution_comment»
comment
Resolution |«resolution_text»
text
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D.2  Sample of clause 5 of the maintenance report base file

The textbox below represents a sample of the clause 5 of the maintenance report base file, including the placeholders needed by the VBA macro in order to copy the outcome of
the Mail Merge operation and create the target maintenance report properly formatted.

5 Comments

This clause collects all the elementary comments obtained by pre-processing the original contributionsin a structured format.

5.1 TS 101 456 - Qualified certificate policy

<insert_table name=T S101456/>

5.2 TS 101 733 - ES electronic signature formats

<insert_table name=T S101733/>

5.3 TS 101 861 - Time stamping profile

<insert_table name=T S101861/>

D.3  Samples of elementary comments within clause 5 of the maintenance report

D.3.1 Introduction

The actual version of the ETSI Maintenance Tools does not perform any formatting operation on the text included in the table cells. Therefore indenting and formatting (es
ASN.1) as shown by the samples (and validated by editHelp! staff) are done manually.
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D.3.2 Examplen. 1

Comment ID | Deliverable | Deliverable Original Comment Comment Resolution Resolution Resolution status Deliverable target
version clause contribution date type source date version
reference
TS101456-007 |1.2.1 6.2 UNSTT-001 technical not yet processed
Comment |Modify the text: "The CA shall oblige, through agreement (see clause 7.3.1 h)), the subscriber to ensure that the subject fulfils the following
text obligations:
a) submit accurate and complete information to the CA in accordance with the requirements of this policy, particularly with regards to
registration;
b) only use the key pair for electronic signatures and in accordance with any other limitations notified to the subscriber (see clause 7.3.4);
c) exercise reasonable care to avoid unauthorized use of the subject's private key;
d) if the subscriber or subject generates the subject's keys:
- generate subject's keys using an algorithm recognized as being fit for the purposes of qualified electronic signatures;
- use a key length and algorithm which is recognized as being fit for the purposes of qualified electronic signatures;
NOTE 1: Itis currently proposed that the recognition of algorithms, with associated key length, being fit for the purposes of qualified certificates is
through a cryptographic advisory panel under the committee identified in article 9 of the Directive [1].
- only the subject holds the private key once delivered to the subject.
e) if the certificate policy requires use of an SSCD (i.e. QCP public + SSCD), only use the certificate with electronic signatures created using
such a device;
NOTE 2: The above item is NOT applicable to qualified certificate policy: QCP public.
f) if the certificate is issued by the CA under certificate policy QCP public + SSCD and the subject's keys are generated under control of the
subscriber, generate the subject's keys within the SSCD to be used for signing;
NOTE 3: The above item is NOT applicable to qualified certificate policy: QCP public.
g) notify the CA without any reasonable delay, if any of the following occur up to the end of the validity period indicated in the certificate:
- the subject's private key has been lost, stolen, potentially compromised; or
- control over the subjects private key has been lost due compromise of activation data (e.g. PIN code) or other reasons; and/or
- inaccuracy or changes to the certificate content, as notified to the subscriber.
h) following compromise, the use of the subject's private key is immediately and permanently discontinued.”
Original New text: "The CA shall oblige, through agreement (see clause 7.3.1 h)), the subscriber:
resolution 1) to make the subject aware (in the case the subscriber and the subject are not the same person) of the CA's terms and conditions as
proposal provided for in clause 7.3.1.a);
2) to ensure that the subject fulfils the following obligations:
a) submit accurate and complete information to the CA, directly or through the subscriber, in accordance with the requirements of this
policy, particularly with regards to registration;
b) only use the key pair for electronic signatures and in accordance with any other limitations notified to the subscriber (see clause 7.3.4);
c) exercise reasonable care to avoid unauthorized use of the subject's private key;
d) idem;
e) idem;
f) idem;
g) notify the CA without any reasonable delay, directly or through the subscriber, if any ...;
h) idem."
Resolution
comment
Resolution
text
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36
D.3.3 Examplen. 2
Comment ID | Deliverable | Deliverable Original Comment Comment Resolution Resolution Resolution status Deliverable target
version clause contribution date type source date version
reference
TS101733-019 |[1.3.1 JCPKI-002 technical already applied
Comment |Pages 49, 67 and 76: "OPTIONAL" should be described after [2] OtherRevVals marked ****.
text Revocat i onVal ues ::= SEQUENCE {
crlVal s [0] SEQUENCE OF Certificatelist OPTI ONAL
ocspVal s [1] SEQUENCE OF Basi cOCSPResponse OPTI ONAL
ot her RevVal s [2] G herRevVvals ****
}
Original "OPTIONAL" should be described after [2] OtherRevVals marked ****
resolution
proposal
Resolution |This problem is fixed in the version 1.4.0.
comment
Resolution
text

D.4

D.4.1

Samples of contribution with metadata within annex A of the maintenance report

Introduction

This annex collects some sample of the contribution with metadata as to be inserted in annex A of the maintenance report.
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D.4.2 Examplen. 1

Contribution metadata
ID contribution TC-ESI_1-001
Source TC-ESI member
Version of the deliverable 1.2.1
Date 14 February 2003
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D.4.3 Examplen. 2

A.2 Comments and proposed amendments from UNINFO-STT (ltaly)
A.2.1 Proposed amendments on TS 101 456

Contribution metadata
ID contribution UNSTT-001
Source Uninfo-STT
Version of the deliverable 1.2.1
Date

Contribution

Introduction
The present document means to give suggestions in order to modify TS 101 456 [Error! Reference sour ce not found.]: the proposed changes
concern both document's stylistic aspects (spelling/syntax) and the content of the deliverable.
For each paragraph to be modified the numeric referenceis given and anew statement is proposed (highlighted in bold): those parts of statement
that have to be deleted are highlighted in bold and struck out.

a) Spelling/Syntax corrections

v 2 References
[9] FIPS PUB 140-2 (2001): " Security Requirements For Cryptographic Modules".
v 4.1 Certification Authority

(first section) "The Certification Authority has overall responsibility for the provision of certification services identified in clause 4.2. The
certification authority isidentified in the certificate astheissuer and itsprivate key isused to sign qualified certificates. "
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